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How to Create an Accessible Excel Workbook  

Introduction 

Accessibility means that something can be accessed by anyone regardless of disability. Accessible workbooks and the 

information therein can be accessed by anyone regardless of how they read. People with print disabilities read in many 

different, non-traditional ways. For example, a person may use a screen reader to read aloud the information in a workbook, or 

they may use a refreshable braille display that displays the data using moveable pins that form the shapes of braille 

characters. People with low vision or cognitive disabilities may want to enlarge text with screen magnification and/or use text-

to-speech software. 

Excel Workbooks are often a very visual medium, but as content creators, we have the opportunity to create content that can 

be accessible to those who read differently. The main changes that we can make involve formatting our workbooks so that 

they do not rely solely on visual cues, including navigation aids like named ranges and navigation info in cell A1, and ensuring 

tables are formatted in the correct way for assistive technology. We can ensure that our content is as readable as possible, 

considering things like colour contrast, font size, and clarity of text. Incorporating features that support accessibility is easy and 

it will make a significant impact for people who access that information differently. For some, it will mean the difference 

between access to information and information that is unreadable. 

The following document outlines the main features in Microsoft Excel that will make a workbook more accessible to people 

who use assistive technology or who have different reading needs.  These simple changes can make your workbooks 

inclusive and accessible. 

Cell A1 

Screen readers read and navigate through an Excel workbook one cell at a time. For this reason, screen reader users may 

struggle to have a complete over-all picture of the document. 

Cell A1 is a critical landmark for structure and navigation. Without a title or some form of direction in cell A1, screen reader 

users may struggle to find the content in your spreadsheet and workbook. Therefore, do not leave cell A1 blank. 

When the document is a simple worksheet only containing a table, you can simply provide a title for the table in cell A1. 

However, when the workbook has a more complex structure (with multiple worksheets or multiple tables within a workbook), 

use cell A1 to provide a summary identifying the cell where each element (i.e. section) starts and stating if the worksheet 

contains tables, charts, graphs, images, anything interactive such as cells that are fillable, and anything irregular or unusual. 

Tip: It is an option to make the text in cell A1 white to match the background, providing it to screen reader users and hiding it 

from view for other readers. However, this text may be helpful to orient other users that do not use screen readers to your 

workbook, so consider leaving it visible. 

Note: If you make the text the same colour as the background, it will come up as a colour contrast error in the accessibility 

checker. The accessibility checker is not a perfect tool. For example, it will not flag an error if cell A1 is blank. 

Naming Cells and Ranges 

Naming cells or ranges provides an additional layer of navigation by allowing users to jump to significant locations within a 

workbook. Do not name every cell, rather name key cells or ranges. 

How to name cells or ranges in a workbook: 

1. Select the cell or range of cells you wish to name. 

2. Navigate to the menu bar and select the Formulas tab. 
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3. Select Define name in the Defined Name area of the ribbon. 

4. Enter the name and select OK. 

5. You can see which cells and ranges have been named by pressing ctrl + g anywhere in your workbook. 

Tip: Cell or range titles cannot contain spaces. It is best practice to use pascal case when naming cells or ranges containing 

multiple words. Pascal case does not contain spaces between words and capitalizes the first letter of each word. 

ThisIsAnExampleOfPascalCase. Do not put symbols such as underscores between each word because this is difficult for a 

screen reader user to understand, as the symbols will be spoken between each word. 

Tip: In a workbook containing multiple pages, use a naming format similar to: WorksheetName_LogicalCellName. In this case, 

using the underscore separates and delineates the two sections of the name and thus is appropriate to use. 

Worksheet Names 

Workbooks in Excel are made up of one or more worksheets. By default, worksheets are titled Sheet1, Sheet2, etc. It is best 

practice to give each sheet a descriptive title that identifies the primary content of the worksheet. As well, delete any blank 

sheets that may be in your workbook, as these may confuse a screen reader user who may search for content somewhere on 

that blank worksheet. 

How to add a title to a worksheet: 

1. Navigate to the tab bar at the bottom of the screen below the cell grid. 

2. Right click on the tab you wish to rename. 

3. Select “Rename” and type in your new name. 

How to delete a blank worksheet: 

1. Navigate to the tab bar at the bottom of the screen below the cell grid. 

2. Right click on the tab you wish to delete. 

3. Select “delete.” 

Tables 

Tables are frequently found within Excel workbooks, and there are several considerations to keep in mind to make them 

accessible. 

Creating tables 

Always use Excel’s table feature to turn your data into a formatted table. Not only does this make tables far easier to navigate 

for assistive technology users, but it makes it easier for you to create charts from your table’s data. 

Remember to rename your table from the default (Table 1, Table 2, etc.). Use a simple, descriptive name that explains the 

table’s contents. 

How to use Excel’s table feature to turn data into a table: 
1. Select the data you wish to be a table. 

2. Press ctrl + t. 

3. Ensure the specified cells match your table. 

4. Check the “My table has headers” box if your table includes column headers. 

How to name a table: 
1. Click anywhere within the table you wish to name. 

2. Navigate to the “Table Design” tab on the menu bar. 

3. Select the “Table Name” box within the Properties area of the ribbon. 

4. Type the name for your table in the box in Pascal case and hit enter. 

TIP: Table titles cannot contain spaces. It is best practice to use Pascal case when naming cells or ranges containing multiple 

words. Pascal case does not contain spaces between words and capitalizes the first letter of each word. 
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ThisIsAnExampleOfPascalCase. Do not put symbols such as underscores between each word because this is difficult for a 

screen reader user to understand, as the symbols will be spoken between each word. 

Simplifying tables 

Above all, simplify the tables you use. Avoid nested tables where there is a table created within another table. Instead, 

separate the nested table out into its own table, and if possible, give each table its own sheet in the workbook. 

When a worksheet has multiple sections or tables, separate each element by a single row. Avoid multiple blank rows or 

columns used to separate content. 

Eliminating blank space within tables 

Wherever possible, avoid unused rows or columns within your table. These blank rows or columns make it difficult for screen 

reader users to understand the content and navigate the table, and they also make it harder for you to turn the table into a 

pivot table or chart. 

Do not merge or split cells. Screen readers count cells to indicate a user’s location within a table. Merged and split cells 

impede screen readers from navigating a table logically and correctly. 

Whenever possible, do not leave cells blank for formatting purposes. If blank cells cannot be avoided, indicate them with text 

such as “N/A” or “intentionally left blank”. This text can be coloured the same as the background of the cell so that it appears 

invisible to sighted readers. If cells are left blank because they are intended to be fillable, leave them blank and indicate their 

location in your navigation instructions in cell A1. 

Indicating Column and Row Titles 

Without specified column and row titles, a table can be difficult for a screen reader user to navigate; a screen reader user will 

simply hear the contents of a cell without any indication of which column or row they are in apart from the cell coordinates. 

This can quickly become confusing, and a screen reader user may rapidly become lost in a table. 

Simply checking the “My table has column headers” box when creating your table isn’t enough to indicate the column and row 

titles. There is a further step you must take. 

How to specify column and row titles: 
1. Remember or write down the exact coordinates of the top left most cell in your table (for example, A1). 

2. Remember or write down the exact coordinates for the bottom right most cell in your table (for example, E55). 

3. Remember or write down the name of the worksheet in which the table is located (you can see this on the tab bar at the 

bottom of the window below the cell grid). 

4. Click on the top left cell in your table. 

5. Navigate to the “Formulas” tab on the menu bar. 

6. Select “Name Manager” in the Defined Names area of the ribbon. You can also get here from within your document by 

pressing CTRL + F3 on the keyboard. 

7. Select “New.” 

8. In the name box, type (without the quotation marks) “Column Title” if your table only has column titles, “RowTitle” if your 

table only has row titles, or “Title” if your table contains both column and row titles. Do not press space afterward. 

9. Type a period (.) and do not press space afterward. 

10.  Type the exact coordinates of the top left most cell in your table. Do not press space afterward. 

11. Type a period (.) and do not press space afterward. 

12. Type the exact coordinates of the bottom right most cell of your table. Do not press space afterward. 

13. Type the name of the worksheet in which your table is located, for example “Budget”. You cannot include spaces, so type 

the title in Pascal case. For example, “BudgetProjections2023”. 

14. Press enter. You will see your name appear in the “Name Manager” list. It should look something like 

“ColumnTitle.A1.E55.Budget2023”, “RowTitle.A1.E55.Budget2023”, or “Title.A1.E55.Budget2023”. 

15. Press ESC to close the dialogue box. 

16. Save your document to save this information, or the defined name will be lost. 

Note: If you add further columns or rows to your table, you must edit the coordinates in the “Name Manager.” 
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Defining boundaries 

It is important to visually define the boundaries of the working area around your table by hiding blank rows and columns. This 

hides the unused portions of the worksheet from view, and thus allows users of screen enhancement and magnification 

software to know they don’t need to keep scrolling for more data. 

It is also important to auditorily mark the boundaries of any tables for screen reader users by writing “End of table” in each cell 

in the row below the table. In complex tables, you may need to also write “End of row” in each cell in the column adjacent to 

the edge of your table. You can match this text to the cell’s background colour to hide it from view for sighted users. 

Note: if you make the text the same colour as the background, it will come up as an error in the accessibility checker. 

How to hide blank rows: 
1. Select a row outside the working area. 

2. Press ctrl + shift + down arrow to select all rows to the sheet’s end. 

3. Navigate to the “Home” tab on the menu bar and select “Format” in the Cells area of the ribbon. 

4. Select “Hide & Unhide” in the Visibility group. 

5. Select “Hide Rows.” 

6. You can also use the shortcut key ctrl + 9 (nine) on your keyboard once you’ve selected the rows to hide. 

How to hide blank columns: 
1. Select a column outside the working area. 

2. Press ctrl + shift + right arrow to select all rows to the sheet’s end. 

3. Navigate to the “Home” tab on the menu bar and select “Format” in the Cells area of the ribbon. 

4. Select “Hide & Unhide” in the Visibility group. 

5. Select “Hide Columns.” 

6. You can also use the shortcut key ctrl + 0 (zero) on your keyboard once you’ve selected the columns to hide. 

Adding table alt text 

It is important to add alternative (or alt) text to your table. This brief description should offer a description of the table’s layout 

and indicate if there are any significant features, such as a total at the bottom. 

How to add alt text to a table: 
1. Select and right-click the table. 

2. Select “Table”. 

3. Select “Alternative Text”. 

4. Add a title and the alt text description to the appropriate boxes. The alt text will be automatically saved when you close the 

box. 

Images, Charts, and Graphs 

All visual content in your workbook, including pictures, graphs, charts, graphics, objects, and SmartArt requires alternative 

text (also known as alt text). This descriptive text is read by screen reading technology to convey the content and meaning of 

a visual element to someone who cannot see that content. If a reader is unable to see the image, all the information relayed in 

that image is unavailable unless there is adequate alt text. The alt text should be concise but include enough information to 

relay the main features of the image. 

Images that convey a lot of information, such as graphs or charts, will need a “long description” as well as alt text. A long 

description (anything more than six sentences) can appear wherever makes sense in the worksheet or workbook, as long as 

it is in the cell layer and not, for example, in a textbox. It can appear in a cell near the image or on an appendix worksheet at 

the end of the workbook. Ensure you always add a brief alt text description to the image itself and include information as to 

where the long description can be found (the cell coordinates, for example). This locational information is also information that 

should be included in your cell A1 information. Your long description may include a table of all the data from the graph or chart. 

Strictly decorative images should be labeled “decorative,” but this only applies if the image does not convey any information. 

An artistic dividing line or symbol at the end of a paragraph or page is an example of a decorative image. 
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Note: Do not use the “mark as decorative” checkbox because this can cause accessibility concerns for screen reader users 

who are running older versions of Microsoft Excel. 

Logos can be described as “logo of…” and the description can include a very brief description of the logo itself. 

Floating objects such as textboxes, shapes, WordArt, and SmartArt are not readable by screen reading technologies. If these 

objects contain vital information, that information must be conveyed in the cell layer of your spreadsheet or workbook. 

Graphs and charts MUST be fully labeled and include, as applicable, a title, a legend, axis labels, and data labels in easily 

legible font (12-point font minimum). 

Never rely solely on colour to convey meaning. Consider using differences in line style, different shades, and/or text within 

graphs. 

Never convert a data table to an image of the table. Use an actual data table within your workbook. 

Whenever possible, avoid using watermarks and background images. 

How to add alt text to an image, chart, graph, etc.: 

1. Select the image, chart, graph, object, etc. 

2. Right click and choose “Edit Alt Text.” 

3. Add a concise description conveying the purpose of the image/object in the context of the document. 

4. If an image is purely decorative, type “decorative” in the alt text box (do not check the “mark as decorative” box). 

5. Close the dialog box (there is no “ok” or “save” button). 

Note: The “Generate a description for me” button relies on artificial intelligence to generate a description of an image. It is not 

effective in creating an alt text description conveying the relevance of the image to your document. While it may offer a good 

starting place from which to craft your alt text description, it is recommended that you do not rely solely upon this feature to 

write alt text. 

Hyperlinks (websites) 

Did you know that screen reader users can extract hyperlinks from a worksheet or workbook and view/browse them as a list? 

Have you ever thought about what it sounds like when a screen reader reads aloud a very long website URL? 

A hyperlink should be embedded in descriptive text that will make sense out of context. If a hyperlink is embedded in non-

descriptive text, such as “click here,” it will not make sense when extracted and presented for browsing by a screen reader. 

Too much information, such as a URL containing a mixture of numbers, letters and symbols, can be confusing and tiring for 

the reader. 

For example, if you are including a link to a step-by-step “how to create accessible hyperlinks” YouTube video, instead of 

using the hyperlink https://www.youtube.com/watch?v=rRec4qjsrSs use descriptive text to indicate the destination of the link: 

how to create accessible hyperlinks. Both hyperlinks will take the reader to the same web page, but the more descriptive link 

provides clarity for the screen reader user.  

How to create a hyperlink from plain text: 

1. Highlight the descriptive text that will become your hyperlink. 

2. Right click and select “Hyperlink” or use the shortcut Control + k. 

3. Add the website/address to the “Address” bar. 

4. The descriptive text should now appear as a hyperlink. 

How to change the name of a hyperlink/URL: 

1. Right click on the hyperlink (or hyperlinked URL).  

https://www.youtube.com/watch?v=rRec4qjsrSs
https://www.youtube.com/watch?v=rRec4qjsrSs
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2. Choose “Edit Hyperlink” from the dropdown menu, or press ctrl + k on the keyboard. 

3. In the “Text to display” box, enter the label/descriptor of the hyperlink.   

4. The hyperlink should now display the updated descriptive version of your URL. 

Colour Contrast 

Colour can highlight important information and serve as a visual indicator. However, for those who have low vision, 

colorblindness or a cognitive disability, the use of color can hinder how well they can see or interpret material. Colour should 

also never be solely used to relay important information. It can be used, but you should consider using other indicators 

alongside the colour. 

Colour contrast is the difference between the value of the foreground colour (usually the font colour) and the background 

colour. If there is not sufficient colour contrast between the foreground and background, some people may not be able to 

differentiate the text from the background, or it may make deciphering the text more difficult than it needs to be. There should 

be sufficient colour contrast to make the text accessible to everyone.  

WCAG (W3C Web Content Accessibility Guidelines) 2.0 level AA requires a contrast ratio of at least 4.5:1 for normal text and 

3:1 for large text. Level AA is a good level to aim for.  

There are many resources that check for sufficient colour contrast. We recommend using WebAIM’s Colour Contrast Checker. 

This tool will tell you if the contrast is sufficient for both normal text and large text. When you enter the known colour values 

into WebAIM’s form, it will tell you if it passes or fails WCAG Level AA or AAA standards. You may also use the slider in the 

tool to find new colour codes that meet the accessibility standards (if yours do not meet them).  

How to find colour values for Font: 

1. Highlight the text. 

2. Go to the Home tab on the ribbon bar and select “Font Colour” found in the Font area of the home ribbon. 

3. Select “More Colours.” 

4. Go to the “Custom” tab. 

5. Under the “Color model” drop-down field, there are three fields (Red, Green, Blue) populated with numbers that make up 

the RGB formula for the colour of the text. 

6. Input these numbers into WebAIM’s contrast checker. Make sure to include the background colour if it is something other 

than white. 

7. The contrast checker will identify which colours “pass” or “fail” the visual test. 

How to find colour values for the background colour of cells: 

1. Select the cell/range of cells/worksheet for which you want the background RGB code. 

2. Navigate to the “Home” tab on the menu bar and select the “Format” dropdown menu in the “Cells” area of the ribbon. 

3. Select “Format Cells.” You can also get here by pressing CTRL + 1 from your worksheet. 

4. Select the “Fill” tab. 

5. Select More Colours. 

6. Go to the Custom tab. 

7. Under the “Color model” drop-down field, there are three fields (Red, Green, Blue) populated with numbers that make up 

the RGB formula for the colour of the background. 

8. Input these numbers into WebAIM’s contrast checker.  

9. The contrast checker will identify which colours “pass” or “fail” the visual test. 

Textboxes  

Text boxes are sometimes used for formatting or to draw attention to a particular part of the document. However, currently text 

boxes are not an accessible feature in Excel. Screen readers will often miss a text box entirely, so even adding alt text is not 

helpful. Therefore, if possible, avoid the use of text boxes in workbooks all together. If text boxes are being used to highlight 

text or for aesthetic reasons, consider using borders and shading around a cell containing the text instead (just make sure 

there is sufficient colour contrast if using shading). 

https://webaim.org/resources/contrastchecker/
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Merged Cells 

Never merge cells in your workbook, even outside of a table. Merged cells are difficult for screen reading technology to read, 

and they may cause screen reader users to miss important content in and around the merged cells. 

Footers and Headers 

Headers and footers hold document information but should never be the only place where important information is provided. 

Screen readers do not automatically identify information in the header/footer and will not read that information unless the 

screen reader user knows to direct the screen reader to do so. Make sure if you add important content to the header/footer, 

you also repeat it in the document. For example, if an AR number is only found in the header or footer of a document, 

someone using a screen reader will not be able to identify the AR number.  

Tip: Do not manually type page numbers into the headers and footers. Use the “Insert” tab then “Header and Footer” > “Page 

Number.” The page numbers may be formatted from there.  

Fonts 

Both font style and font size are important to consider when creating a workbook. At least 11-point font size should be used 

within the main body of text (12-14 point is even better, especially for printed documents) and a minimum 9-point size in 

headers and footers. The font sizes should allow for zoom or magnification without being distorted.  

Some fonts are easier to read than others. It is best practice to use clear and easy to read fonts (often recommended are 

sans-serif fonts), such as Arial, Calibri, and Verdana.  

Accessibility Checker 

Microsoft Office has a built-in Accessibility Checker, which finds accessibility issues and warnings, explains the reasons for 

them, and offers solutions.  

Please note that the Accessibility Checker is an automated tool and will not catch every accessibility issue that may exist in 

your workbook. It is best used in conjunction with awareness about accessibility features as well as a manual check.  

Issues that should be manually inspected include:  

• Alternative text quality 

• Complex image descriptions 

• Captions 

• Use of cell A1 

• Descriptive links 

How to Access the Accessibility Checker: 

1. Go to the “Review” tab on the ribbon bar and select “Check Accessibility” under the Accessibility area of the ribbon. 

2. Choose “Check Accessibility”. 

3. The Accessibility panel will open on the right-hand side of the window and will display any accessibility errors it has 

detected along with explanations and ways to fix them. 

Tip: Check the Keep accessibility checker running while I work checkbox to be notified of accessibility errors while you 

work. 

PDF Documents 

If you are making your Excel workbook accessible, you will want to make sure that all that work is maintained if you are 

converting your document to a PDF. If you save it correctly, the accessibility information will be kept intact when converted to 

PDF. 
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Sometimes PDFs are strictly images and screen readers cannot access the content at all. For example, when a document is 

physically scanned on a photocopier scanner and sent to an email, that content is one big image, even if it looks like text. And 

that image is inaccessible to screen readers.  

Avoid the “print to PDF” function when you are saving a document that is going to be shared. Always save PDFs as per the 

instructions below so that they can be accessed by all readers. 

People who have dyslexia or other cognitive differences may access content by modifying the document in ways that suit their 

own reading requirements, such as changing the font or spacing. Because PDFs do not allow for adjustment, they are not 

considered a very accessible format and can pose challenges for some readers. If you are required to use PDFs, please make 

other formats available or, at a minimum, indicate that other formats are available upon request.  

How to save as PDF: 

There are two methods available to save your Excel workbook as an accessible PDF file depending on whether you have an 

Adobe add-in installed on your computer for Excel. 

Saving a Document as PDF if you have the Adobe Add-In: 

1) Either navigate to the “File” tab on the ribbon bar and choose “Save as Adobe PDF,” or go to the “Acrobat” tab on the 

ribbon bar and choose “Create PDF.” 

2) select Options and ensure “Enable Accessibility and Reflow with Tagged Adobe PDF” and “Create Bookmarks” are both 

checked. 

Saving a Document as PDF without the Adobe Add-In: 

1) Navigate to the File tab on the ribbon bar and select Save As. 

2) Select PDF as the “Save as type” 

3) Select Options. 

4) Check the “Document structure tags for accessibility” checkbox. 

Tip: Adobe also has a built-in accessibility checker that can be used to identify accessibility issues in a PDF document. 

Final Thoughts 

An accessible workbook is actually a well-structured document and will benefit everyone. We all have the power to make the 

world a bit more accessible. Let’s use that power and build more accessible resources for Albertans and other GoA 

employees.  

Please share information and resources with colleagues, even those you think are the “experts.” We are all learning together 

and there is so much we can learn from one another. 

Accessible Workbook Checklist 

If it is helpful, please use the following checklist to review your workbooks for accessibility. 

Accessible Workbook Features Y/N 

Cell A1: Cell A1 is not blank and it contains important navigation information for screen reader 

users. 

 

Named Cells and Ranges: Key cells and ranges have been defined and appear in the list 

when you press ctrl + g.   
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Accessible Workbook Features Y/N 

Worksheet Names: All worksheets in the workbook have descriptive names and all blank 

worksheets have been removed. 

 

Headers and Footers: Important information (title, AR number, etc.) is stated somewhere 

other than in the header and/or footer. 

 

Font: Font is Sans Serif and is at least 11 point in body text and at least 9 point in headers 

and footers. 

 

Tables: Cells in tables are not merged or split.  
 

Tables: The Header Row is repeated at the top of the table (header row checkbox is ticked). 
 

Tables: All tables are created using the table function. 
 

Tables: All tables have descriptive names. 
 

Tables: nested tables are avoided. 
 

Tables: There is only one blank row separating multiple tables in a worksheet. 
 

Tables: Tables do not contain any blank rows or columns. 
 

Tables: Non-fillable cells required to be left blank for formatting purposes say "N/A" or 

"Intentionally left blank." 

 

Tables: Column and/or Row titles are indicated through the "Name Manager." 
 

Tables: Blank rows and columns around your working area are hidden. 
 

Tables: The row following the end of a table is marked with "End of table" in each cell below 

the table. 

 

Tables: All tables have alt text. 
 

Graphs and Charts: As applicable, graphs and charts contain a title, a legend, axis labels, 

and data labels. 

 

Graphs and Charts: Meaning is not solely conveyed through colour. 
 

Images, Graphs, and Charts: Alt text has been added to all images, graphics, charts, and 

graphs. 
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Accessible Workbook Features Y/N 

Complex Images, Graphs and Charts: Long descriptions have been added to all complex 

images, graphs, and charts. 

 

Hyperlinks: Hyperlinks are embedded in descriptive/meaningful text. 
 

Text Boxes: Text boxes have been avoided. If needed for formatting or aesthetic reasons, 

cell borders and shading are used instead.  

 

Merged Cells: Merged cells are avoided in all areas of a workbook. 
 

Colour Contrast: Any colour (other than any black and white combination) has been checked 

for sufficient colour contrast.  

 

Accessibility Checker: The workbook has been checked by the Excel Accessibility Checker 

and all issues have been addressed.  

 

Saving as PDF: If saving document as a PDF without the Adobe add-in, “Document structure 

tags for accessibility” has been selected. 

 

Saving as PDF: If saving document as PDF with the Adobe add-in, “Enable Accessibility and 

Reflow with Tagged Adobe PDF” and “Create Bookmarks” are both checked. 

 

 

Resources 

Here are some great additional resources for creating accessible workbooks. 

Accessibility for Excel 

• Office Accessibility Center - Resources for people with disabilities 

• Microsoft Support: Accessibility Checker 

• Microsoft Support: Rules for the Accessibility Checker 

• Microsoft Support: Accessible Hyperlinks (Video is for Microsoft Word, but the process is the same for Excel). 

• Microsoft Support: Creating Accessible Excel Documents 

• Microsoft Support: Create Accessible Charts in Excel 

• Microsoft Support: Templates: Get templates designed for accessibility 

• Microsoft Support: Create a template 

• Microsoft Support: Use color and contrast for accessibility 

Accessibility for PDF 

• Create and verify PDF accessibility (Acrobat Pro): Walks through the built-in checker 

• Creating accessible PDFs: Explains how to create an accessible PDF and has a lot of useful information on Accessibility for 

PDFs 

• PDA/UA foundation: is one of the organizations that creates standards for accessibility in PDFs 

• PDA/UA has a free checker App: though we recommend using Adobe Acrobat Pro’s built-in checker. 

• PDF Techniques for WCAG 2.0: this document breaks down all the applications you can use for creating an accessible 

document. Word and Adobe are the most accessible. 

https://support.microsoft.com/en-us/office/office-accessibility-center-resources-for-people-with-disabilities-ecab0fcf-d143-4fe8-a2ff-6cd596bddc6d?redirectsourcepath=%252fen-us%252farticle%252faccessibility-in-office-365-aca7accf-58a0-4467-be5c-24a7e7933a9d
https://support.microsoft.com/en-us/office/make-your-content-accessible-to-everyone-with-the-accessibility-checker-38059c2d-45ef-4830-9797-618f0e96f3ab
https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/office/video-create-accessible-links-in-word-28305cc8-3be2-417c-a313-dc22082d1ee0?ui=en-us&rs=en-us&ad=us
https://support.microsoft.com/en-au/office/make-your-excel-documents-accessible-to-people-with-disabilities-6cc05fc5-1314-48b5-8eb3-683e49b3e593
https://support.microsoft.com/en-au/office/video-create-more-accessible-charts-in-excel-19e81ce7-88af-4a3f-a4ef-a26c344527b3
https://support.microsoft.com/en-us/office/video-start-with-an-accessible-excel-template-918db751-1585-41c5-9ddf-5d7a0915afaf
https://support.microsoft.com/en-us/office/create-a-template-86a1d089-5ae2-4d53-9042-1191bce57deb
https://support.microsoft.com/en-us/office/use-color-and-contrast-for-accessibility-in-microsoft-365-bb11486d-fc7d-4cd9-b344-16e2bc2a2387
https://helpx.adobe.com/ca/acrobat/using/create-verify-pdf-accessibility.html
https://helpx.adobe.com/ca/acrobat/using/creating-accessible-pdfs.html
https://pdfua.foundation/en
https://pdfua.foundation/en/pdf-accessibility-checker-pac
https://www.w3.org/TR/WCAG20-TECHS/pdf
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• TPGI YouTube Video on Intro to Accessible PDFs: free online tutorial for checking and fixing a PDF 

• TGIF article on PDF accessibility 

Creating Image Descriptions for Alt-text 

• Describing Images in Publications is a DAISY webinar that introduces Image Descriptions 

• The Art and Science of Describing Images Part Two is a DAISY webinar that goes into describing Maps, Graphs, and 

Charts 

• W3C's Tutorial on Images focuses more on websites, but has useful tips for describing symbols and images in sequence. 

• AccessiblePublishing.ca Guide to Image Description provides general guidelines for publishers. This page was created by 

our accessibility testing team. 

• Poet Training Tool provides an interactive tutorial on how to describe all types of images, and is great to practice your 

writing skills! 

• Long description techniques: DAISY Knowledge Base 

• WCAG Techniques for Long description: G73 – G74 – G92 

• The Art and Science of Describing Images Part Two: DAISY webinar that goes into describing Maps, Graphs, and Charts 

Other Useful Links 

• NNELS Services: Includes information on paid workshops on Alt-text and more! 

• WebAIM: Colour contrast checker that checks for sufficient contrast between the text and the background. Tip: If your 

contrast fails, use the slider bar to find a colour that is close to the original that you can use.  

• WCAG Contrast Checker: Colour contrast checker. You can import pictures to check for compliance. The checker also has 

a colour blindness simulator. 

Useful recorded Webinars on Excel accessibility 

• Creating Accessible Excel Spreadsheets 

 

https://www.youtube.com/watch?v=5Vb0fJ5p7Mo
https://www.tpgi.com/pdf-accessibility/
https://daisy.org/news-events/articles/describing-images-in-publications-w/
https://daisy.org/news-events/articles/art-science-describing-images-part-2-w/
https://www.w3.org/WAI/tutorials/images/
https://www.accessiblepublishing.ca/a-guide-to-image-description/
http://diagramcenter.org/making-images-accessible.html
http://kb.daisy.org/publishing/docs/html/images.html
https://www.w3.org/WAI/WCAG21/Techniques/general/G73
https://www.w3.org/WAI/WCAG21/Techniques/general/G74
https://www.w3.org/WAI/WCAG21/Techniques/general/G92
https://daisy.org/news-events/articles/art-science-describing-images-part-2-w/
https://nnels.ca/services-publishers
https://webaim.org/resources/contrastchecker/
https://contrastchecker.com/
https://www.youtube.com/watch?v=CcyeL3BKQQY

